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This document provides an overview of the new features and enhancements in PlanetPress® Connect 
1.1 and PlanetPress® Workflow 8.1. 
 
 
Installing PlanetPress® Connect Version 1.1 and PlanetPress® Workflow 8.1: 
 

 From version 1.1, PlanetPress® Connect is released as a 64 Bit version only (with the 
exception of the Workflow, Fax, Search and Imaging modules). 

 

 Full details on downloading, installing and licensing PlanetPress® Connect 1.1 and 
PlanetPress® Workflow 8.1 can be found in the accompanying “PlanetPress Connect Version 
1.1 - Installation and Activation” document.  

 

 Note that both PlanetPress® Connect 1.1 and PlanetPress® Workflow 8.1 come with 30 day 
trial licenses by default. 

 
 
Updating from PlanetPress® Connect Version 1.0.0\1.0.1  
 

 If you have installed PlanetPress® Connect 1.0.0\1.0.1 and have configured the Product 
Update Manager to check for newer versions, you will automatically be prompted to update 
your installation to 1.1.  

 

 Seamless upgrades are possible from the earlier 32 bit versions to the new 64 bit version. The 
Version 1.1 installer will first prompt you to uninstall the previous version before starting the 
1.1 installation. For more information please see the “PlanetPress Connect Version 1.1 - 
Installation and Activation” document. 

 
 
Print Only Version: 
 

 A Print Only license is available with version 1.1 of PlanetPress® Connect which allows legacy 
PlanetPress® Suite 7 customers on OL Care to upgrade to Connect for a minimal fee. The 
license allows regular printing via the Print Wizard but runs Email and Web output in demo 
mode. For more information, please contact your local OL Customer Care or Sales team. 
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1. Extended Support for Capture OnTheGo (SHARED-29274 & 28838) 

 
PlanetPress® Connect 1.1 provides powerful new functionality for introducing Capture OnTheGo 
(COTG) Form Elements to Web Contexts and sending documents to the mobile application from the 
Designer. 
 
To insert Capture OnTheGo Form Elements you must first create a Web Context in the Designer and 
insert a regular “Form” type Form Element. 
 
Once you have done so, right click in the Form to open the context menu. It will contain a “COTG 
Form Elements” menu from where all standard COTG elements can be inserted: 
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Sending test documents to the mobile application: 
 
A new option is available in the File menu called “Send COTG Test” which opens the “Send COTG 
Test” wizard: 

 
 
This wizard can also be opened using Ctrl+F12 or the following new button in the toolbar: 
 

 
 
The Store ID, Password and Recipient must be specified along with general information about the 
document. The form is sent by pressing “Finish” in the dialog and shortly afterwards, if the specified 
credentials are correct, it becomes available on the Capture OnTheGo app. 
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2. Support for IMPB Barcodes (SHARED-27048 & 27298) 

 

 

 
 
 
Version 1.1 provides support for IMPB barcodes: 
 

1. Click on the barcode icon in the toolbar to open up the 
barcode selection list. 

 
2. Select “IMPB” – an IMPB barcode is inserted into the 

template. 
 

Note that unlike other barcode types, no properties are 
associated with the IMPB Barcode. This means that when you 
select the barcode and right click, no options for specifying its 
properties are displayed in the context menu. 

 
  

3. PCL and PostScript Input for the DataMapper (SHARED-29276 & 27336) 

 

PCL and PostScript files can now be used as input in the DataMapper. Note that PCL requires an 
additional feature which is licensed separately. A standalone setup is available which installs the PCL 
input plugin. This is then activated in the PlanetPress Connect license. For more information please 
contact your local OL Sales representative. 
 
Also note that the conversion of both PCL and PostScript input files is carried out at Server level. This 
means that conversions of PCL and PostScript files do not work with standalone installations of the 
Designer and Server must be installed. 
 

4. CSV Files in the DataMapper (SHARED-26905) 

 

The DataMapper can now use CSV files with extensions other than .csv. 
 

5. Packaging Templates and Data Mappings (SHARED-26510) 

 
When packaging a template or data mapping, if the editor is set as dirty, the user is now asked if they 
wish to save the configuration or template before packaging the files.  
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6. Inserting Common HTML Elements (SHARED-26036) 

 
Common HTML elements can now be inserted directly into templates via a new “Structural 
Elements” option in the “Insert” menu: 
 

 
 

These options simplify the setting up of web pages within the Designer. For example, when creating 
web pages that are based on the Foundation or Bootstrap frameworks, you can now insert the 
various <div> elements and insert nested <div> elements required to create the rows and columns. 
There is no need to go into the Source view to set these up. 
 
 

7. Inserting Form Elements (SHARED-27148 & 27343) 

 
Form elements can now be inserted directly into templates via a new “Form Elements” option in the 
“Insert” menu: 
 

 

 
 
 
 
 
Buttons for Form Elements are also available in 
the toolbar: 
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8. Improvements to the Creation and Editing of Templates (SHARED-26325) 

 
A number of improvements have been made around the creation and editing of templates. These 
include: 
 

1. <input> elements now always start on a new line (SHARED-27341) 

2. Various improvements have been made to the Foundation Wizards (SHARED-27484) 

3. The border of the page is now always on top (SHARED-27182) 

4. Margin lines no longer disappear when adding a background PDF to a master page (SHARED-

26770) 

5. Improved handling of tables via the Insert Table wizard (SHARED-19508 & 27306) 

6. The Wrap in Span option now uses the Insert Element dialog (SHARED-26788) 

 

 

9. Improvements to Scripting (SHARED-26045) 

 

The following enhancements have been made around scripting: 
 

1. Scripts can now be imported and exported using drag and drop (SHARED-27032) 

2. Multiple classnames can now be set in a single command via addClass() (SHARED-27661) 

3. Scripts can be enabled/disabled via the context menu of the Scripts panel (SHARED-26864) 

4. New import and export options have been added to the context menu and toolbar of the 

Scripts panel\view (SHARED-28610) 

5. The user is now prevented from entering names with Windows reserved characters 

(SHARED-27289) 

6. A Remove () function has been implemented (SHARED-27378) 

7. The selected folder is now opened when creating a new folder or script in the Scripts Panel 

(SHARED-26925) 

8. Improved deletion of multiple scripts (SHARED-27952) 

9. The export of script folders has been improved (SHARED-29210) 

10. Code completion options have been extended to incorporate JSON and Math calls (SHARED-

28620) 

11. The duplicate command is now available in the context menu of the Scripts panel (SHARED-

28188) 

12. Script support for adding CC and BCC fields based on data for email output (SHARED-28195) 
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10. Control Scripts (SHARED-27367) 

 

Version 1.1 includes support for Control Scripts for managing aspects of the output based on data 
fields or the current output channel. For example skip/print section, defining email attachments, 
creating multiple attachments, etc. 
 
 

11. JavaScript Files and Stylesheets (SHARED-27229) 

 
It is now possible to link to remote JavaScript files and CSS stylesheets, considerably simplifying the 
setting up of templates that share resources. 
 
 

12. Workflow: Default HTTP Process (SHARED-25740) 

 

A default HTTP process has been added for a URL call to the server. If you enter the URL of the 
Workflow server without an action, such as http://localhost:8080/, you can now define the default 
process that is called.  
 
 

13. Improved Meta Data Support for PDF\VT (SHARED-22356) 

 
Meta Data support has been improved for PDF\VT in Version 1.1. It can be applied to PDF\VT output 
using the following checkbox in the Job Creation dialog and the Print Options: 
 

 
 
This enables the Meta Data options page in which you can set up tags for the Meta Data: 
 

 
 

 

14. Support for Background Printing (SHARED-26155) 

 
Support for background printing has been added so that you can continue working while Connect is 
printing. 
 
 
 

http://localhost:8080/
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15. Hiding\Displaying Printer Models (SHARED-27315, 29090 & 28860) 

 
The Printer Models displayed in the Print Wizard can now be turned on or off using the Preferences 
dialog in the Window menu. Note that when first installing Version 1.1, only Generic PDF is displayed 
in the Print Wizard. Any required models must be switched on using the checkboxes in the following 
dialog: 

 
 
 

16. Print Wizard: Media Sizes and Custom Pages (SHARED-27178 & 27180) 

 
More standard media sizes have been added to the Print Wizard and custom page sizes have been 
added to the Printer Definition Wizard. 
 

17. Print Wizard: Input\Data File Name (SHARED-27858) 

 
An option is now provided in the Job Output Mask to allow the input/datafile name to be included 
within the Job Output filename.   
 

18. New Proof Print Button (SHARED-25884) 

 
A new button has been added to the toolbar for initiating the Proof Print dialog: 
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19. Print Wizard: Dynamic Folder and File Names (SHARED-27414) 

 

The Print Wizard now supports dynamic file and folder names for automation through PlanetPress 
Workflow. Examples of how to create the dynamic names are shown in the Job Output Mask and 
Folder settings below: 
 

 
 
 

20. Print Wizard: Adding Text and Barcodes to Selected Document Pages (SHARED-27940) 

 
The Print Wizard now allows additional text and barcodes to be added to any page in the output 
using JavaScript in the background: 
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21. Print Wizard: Selective Inserts (SHARED-25292) 

 

Selective inserts are now supported for the inserter machine selected in the Print Wizard: 

 

1. Open the Print Wizard and step through to the Print Options wizard page 

2. Check the “Add Inserter marks” check box 

3. Click Next until you step through to the “Inserter Options” wizard page 

4. Select an Inserter model via the browse button or a previously selected inserter model if one 
is available in the drop down list 

5. In the Options section select a “Mark Configuration” that supports selective inserts. i.e., 
"OMR - Selective", "OMR - Selective + Integrity", "Code39 barcode - Selective" etc. This will 
populate the Selective Inserts table with all the marks that can be turned on or off. 

6. For each selective mark you can edit the selection state by selecting a mark in the table and 
either clicking the edit button next to the table or double-clicking the mark entry in the table. 
This will open the Selective Insert dialog 

7. In the Selective insert dialog a selective mark can be set to one of three states:  

 No - This means the mark will be turned off for all documents at output time 

 Yes - This means the mark will be turned on for all documents at output time 

 Conditional - This allows you to set a boolean condition that determines when the 
mark is turned on or off. See the Conditions section below for more information. 
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Conditions 

A condition is a boolean javascript expression that can use any standard field (some common 
ones are available in the popup menu access via the button next to the condition field) or 
meta data field that has been defined in Job Creation.  

Some example conditions are: 

 Turning a mark on for every second document:  

document.sequence.job % 2 == 0 

 Turning a mark on when a metadata field is a particular value:  

document.metadata.Gender == "M." 

 
 
 

22. Print Wizard: Booklet Impositioning (SHARED-28527, 28529, 28534 & 28536) 

 

Version 1.1 now supports Booklet Impositioning via the following checkbox in the Print Options: 
 

 
 

When this is selected a new “Booklet Options Page” appears in the Print Wizard which allows you to 
make your required booklet settings. For example: 
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Enhancements in PlanetPress® Connect 1.1 and PlanetPress® Workflow 8.1 over the previous 
releases include the following: 
 

1. General 

 
1. The expiration date in the Software Activation dialog was incorrect for expired licenses. This 

has been fixed (SHARED-19733) 

2. Opening the Server Configuration tool was resulting in the preferences dialog being 
displayed as well as an inaccessible 'Connect Server Configuration' application. This has been 
fixed (SHARED-21079)  

 
3. Connect Server temporary folders were only being cleaned after the server was restarted. 

This has been fixed (SHARED-22385) 

 
4. Installing Connect could sometime fail when a specific user folder did not exist. The installer 

now checks whether the user folder is missing and asks the user to log on to the account. 

(SHARED-25031) 

 
5. The “Uninstall completed successfully” dialog was not always closing following an uninstall. This 

has been fixed (SHARED-26847) 

 
6. The Update Page was not indicating the URL of the repository from which it should be 

updated. This has been fixed (SHARED-26181) 
 

7. The merge engines were not always started after installing Connect on Windows Server 

2008 x64. This has been fixed (SHARED-25166) 

 

8. When creating a package and then browsing for the data mapping config instead of using the 

currently opened one, a warning was produced that the preview could not be created. This 

was because the input file could not be found and has now been fixed (SHARED-25219) 

 

9. Double-clicking on a template or DataMapper was creating a workspace folder at the job 

location. This has been fixed (SHARED-26237) 

 

10. The license file details for demo licenses were not being displayed correctly in the Licence 

File Details dialog. This has been fixed (SHARED-26524) 

 

11. Improved handling of pre-processors when one pre-processor is deleted (SHARED-26868) 

 

12. MySQL and HSQLDB tables are now created under %PROGRAMDATA%\Connect\MySQL or 

HSQLDB as storing the data in a specific user folder was previously causing issues (SHARED-

27071 and 27072)  

 
13. General improvements to the online help (SHARED-18807) 
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14. Failed connections to the server are now logged so that administrators have a record of 

attempts to access the server (SHARED-28495) 

 
15. When installing Connect on a Mac Mini with Windows 8.1, the magic number for the license 

could not be generated. This has been fixed (SHARED-28283) 

 
 

2. DataMapping 

 
1. When adding an extraction step in XML there were problems with the returned XPath. These 

have been fixed (SHARED-4094) 

 

2. Improved datafile detection with data mapping configurations (SHARED-9404)  

 

3. Scrolling in the Workflow viewer has been improved (SHARED-10361) 

 

4. Background colours improved for the Extractor and Editor in the DataMapper to bring them 

in line with the system colour (SHARED-11737) 

 

5. Internal server errors were sometime being logged when trying to create a PDF data 

mapping. This has been fixed (SHARED-11913) 

6. In the DataMapper the [Action] step was generating the same [Name] if the step was in a 
[Loop] or [Condition] step. This has been fixed (SHARED-11664) 
 

7. The [Close Others] option was greyed out when a template or DataMapper config were 

open. This has been fixed (SHARED-13051) 

 

8. Additional Help buttons have been added to the DataMapper perspective (SHARED-13820) 

 

9. “Error while retrieving character data” fixed when printing certain PDF DataMapper configs 

(SHARED-14177) 

 

10. Error fixed in logs when trying to open a PDF config a second time (SHARED-15393) 

 

11. When opening multiple templates consecutively that used the same DM Config the data 

could not always be synchronised. This has been fixed (SHARED-17368) 

 

12. A previously unsaved DataMapper Config could sometimes be opened when creating a new 

template. This has been fixed (SHARED-17415) 

 
13. Spaces were being  trimmed from left and right for [Password] in SQL Server. This has been 

fixed (SHARED-20093) 

 

14. Improved messaging around databases with empty tables (SHARED-20305) 

 

15. The [PDF Viewer] was not being refreshed after changing the view of the document from <all 

as one page> to <divide pages according to the script>. This has been fixed (SHARED-20714) 
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16. When the user Synchronizes their data model on the DataMapper, if one or more of the 

fields do not have the same type in both models the synchronisation will fail. To assist the 

user in indentifying why the synchronisation failed, the background of the type icon is now 

changed to red. (SHARED-21782) 

 

17. The DataMapper PDF mode was extremely slow with loading a PDF data file after a fresh 

installation. This has been fixed (SHARED-23063) 

 
18. An MS Access data sample file could still be locked after closing the data mapping 

configuration. This has been fixed (SHARED-25920) 

 

19. Improved handling of Arabic and Right-To-Left languages in the DataMapper editor and data 

model (SHARED-26083, 26575 & 26946) 

 

20. DataMapper configs were being saved in Temp after printing. This has been fixed (SHARED-

26333) 

 
21. Editing the data model was not setting the DataMapper to dirty. This has been fixed 

(SHARED-26438) 

 
22. It was not possible to delete a table from the top level of a data model. This has been fixed 

(SHARED-26432) 

 

23. A StackOverflowError was sometimes being thrown in the Data Wizard. This has been fixed 

(SHARED-27353) 

 

24. The loading of large datafiles has now been improved (SHARED-28792) 

 

25. If the “Skip Next” step found the condition met on the final line of data, it would set the 

current line to the next line which was incorrect. Any attempt to then extract data would fail. 

This has been fixed (SHARED-28753) 

 

26. The data model could not be synchronized when the DataMapper config was opened 

followed by a template with a different data model. This has been fixed (SHARED-28113) 

 

27. The zooming shortcuts were not working correctly in the DataMapper. This has been fixed 

(SHARED-27905) 

 
28. The “Default value” option was not present in the Data Model view for data fields created 

during an extraction step. This has been fixed (SHARED-27505) 
 

29. Progress bars have been added when opening PDF\VT files in the DataMapper (SHARED-
15376) 
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3. Designer 

 
1. Multi-selection is now possible in the Resources view (SHARED-28765) 

 

2. It is now possible to update records in Create Web Content (SHARED-28676) 

 

3. Sections can now be re-ordered by dragging (SHARED-28606) 

 

4. Page numbers can now be continued across subsequent sections (SHARED-28139) 

 

5. JavaScript resources can now be dragged from the Resources panel straight into a print 

section (SHARED-27610) 

 

6. It is no longer possible to undock the DataMapper and Designer main views (SHARED-3033) 

 
7. In the Source View, “go to line” would always jump to line 1. This has been fixed (SHARED-

12409) 

 

8. Text quality has been improved in boxes with a transparent background colour (SHARED-

16180) 

 
9. Improved handling of error messages if the DataMapper cannot be located when opening a 

template (SHARED-18396) 

 

10. The Welcome screen was previously appearing when opening Connect by double-clicking on 

a template. This has been fixed (SHARED-20645) 

 

11. Improved tooltip handling on untitled templates (SHARED-22664) 

 

12. An image located on a local drive would appear in the Designer but was not always printed. 

This has now been fixed (SHARED-24260) 

 

13. Incorrect error messages were sometimes appearing in the log when migrating documents 

from beta and release candidate versions of Connect. This has been fixed (SHARED-24438) 

 

14. When editing hyperlinks, sometimes the edit mode would stick if only part of the hyperlink 

had been selected. This has been fixed (SHARED-25623) 

 

15. Various menu items and buttons were available in Live view when those functions were not 

supported in that mode. This has now been fixed (SHARED-25727) 

 

16. Using “Skip to next occurrence” in a repeat step could cause the line to be extracted twice. 

This has been fixed (SHARED-25729) 

 

17. Javascript errors were not always being shown in Live mode. This has been fixed (SHARED-

25899) 
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18. A page break before an image was not always implementing the page break. This has been 

fixed (SHARED-26132) 

 

19. Border helpers for nested objects are now shown in the correct positions (SHARED-26197) 

 

20. Business graphics no longer require a unique ID in order to be rendered (SHARED-26287) 

 

21. Package Files were generating an error in the preview when the template and data were 

incompatible with one another. This has been fixed (SHARED-26751) 

 

22. Improved drag and drop handling in the Resources panel (SHARED-27190) 

 

23. Shorthand CSS properties were not being properly parsed in the Stylesheet Editor. This has 

been fixed (SHARED-27204) 

 

24. Undo was not working correctly after inserting an image from a file. This has been fixed 

(SHARED-27208) 

 

25. The script logger was sometimes producing output in the Messages window after every 

keystroke. This has been fixed (SHARED-29306) 

 

26. A null pointer exception was sometimes occurring when creating shared content. This has 

been fixed (SHARED-27231) 

 

27. Messaging improved in the Attributes panel around ID and class values (SHARED-27252) 

 

28. It was sometimes not possible to open stylesheets which contained multiple non-ASCII 

characters. This has been fixed (SHARED-27255) 

 

29. An error could sometimes occur when saving a template while the CSS editor was open. This 

has been fixed (SHARED-27259) 

 

30. Fields in nested tables were showing the value of the previous record. This has been fixed 

(SHARED-27308) 

 

31. Renaming an open Snippet was causing it to lose its changes (SHARED-27332) 

 

32. Improvements have been made when deleting resources (SHARED-27371) 

 
33. When using the "external browser" button in the Designer with IE 11, the preview did not 

contain any linked resources or images. This has been fixed (SHARED-27427) 
 

34. The Designer could sometimes be found to be non-operational if the user had stepped 

backwards and forwards several times in the installer. This has been fixed (SHARED-27431) 

 

35. When dragging and dropping an SVG image from one part of the template into another, the 

image was not moving and empty lines were being added. This has been fixed (SHARED-

27493) 
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36. Null pointer exceptions were sometimes occurring during web previews. This has been fixed 

(SHARED-29241) 

 

37. Database files were not always being released after the Designer had finished with them. 

This has been fixed (SHARDED-29211) 

 

38. Users were being prompted to save changes when deleting new sections that did not 

contain any modifications. This has been fixed (SHARED-29169) 

 

39. The Designer would sometimes freeze when inserting page breaks into duplex jobs. This has 

been fixed (SHARED-29099) 

 

40. Undoing the deletion of a new Print Section would not update the view in the Resources 

pane. This has been fixed (SHARED-28983) 

 

41. The name of the active resource is now shown in the editor tab (SHARED-28720) 

 

42. <div> and <article> elements now always start on a new line in HTML (SHARED-28613) 

 

43. Manually typed Cyrillic text was being displayed incorrectly. This has been fixed (SHARED-

28467) 

 

44. Inline styles are no longer applied to “Wrap in Box” objects (SHARED-28239) 

 

45. The whitespace element is now only available in the print context (SHARED 27912) 

 

46. Some minor copy/cut issues have been fixed in the Outline view (SHARED-27870) 

 

47. The position of an Absolute Positioning Box (Abs Box) on a Master page was not updated 

when changing the X and Y coordinates in the Attributes panel. This has been fixed (SHARED-

27817) 

 

48. The Page Count value was displaying as "undefined" in Preview mode. This has been fixed 

(SHARED-27669) 

 

49. "Absolute Positioned" child elements contained within "Relative Position" page elements 

did not work correctly.  This has been fixed (SHARED-27743) 

 
50. Custom processing is now allowed in Weaver via REST server calls (SHARED-29031) 
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4. Workflow 

 
1. Imaging and Fax can now use the metadata inside PDF/VT files generated by Connect in 

order to index, archive and fax documents (LPPS-23760) 
 

2. The Create Web Content task is now able to have Connect generate and serve Web pages via 
the HTTPS protocol (LPPS-24096) 
 

3. The commingling option of the Retrieve Items task now correctly sorts and groups retrieved 
documents (LPPS-24055) 
 

4. A single Connect Proxy identification panel is now available in the Workflow preferences. 
This allows users to specify a default set of connection parameters while allowing each 
individual Connect-related task to override those parameters if need be (LPPS-24054) 
 

5. A new SMTP Input task is available to act as an Email Server proxy. This allows users to 
intercept outbound emails and repurpose them  using Connect technology (LPPS-23964) 
 

6. A new Logger task can be used to send custom messages to the Workflow log or to the 
Windows System/Application logs (LPPS-23579) 
 

7. The SharePoint Input task can now retrieve password protected PDF files (LPPS-24060) 
 

8. The Create Email Content task now has an option to specify which section from the template 
should be generated (LPPS-24100) 
 

9. The HTTP requests received through the HTTP Input task now specify the proper encoding so 
they can be used with any XML-compliant application, including Connect(LPPS-23987) 
 

10. The Print Using a Windows Driver task now has a shrink to fit option to remove potential 
extra margins from printed PDF files  (LPPS-22234) 
 

11. The Connect Package contents are now listed in the Workflow Components panel alongside 
the other available components (LPPS-23857) 
 

12. A new Import Connect Content option allows users to import Connect packages into 
Workflow. This is useful, for instance, when the Connect Designer cannot send packages 
directly to Workflow because the latter is on a different network or has restricted access. 
(LPPS-23974) 
 

13. A new View as HTML option is available in Debug mode to display the current job file in the 
system browser. 
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5. Print Wizard\Output 

 
1. Name validation has been added for the Job Output Mask in the Print Wizard (SHARED-9081) 

 

2. The Media Mapping weight can now be edited in the range of 55 to 350 (SHARED-28512) 

 

3. Documents were sometimes not rotated at in the output when “Rotate document 180 

degrees” was selected. This has been fixed (SHARED-7075) 

 

4. The page orientation was always defaulting to portrait with PostScript output when stapling 

was set. This has been fixed. (SHARED-23567) 

 

5. Numeric sorting was incorrect for Negative Floats. This has been fixed (SHARED-24032) 

 

6. The Output Creation Settings option was not working in the Data Mapping view. This has 

been fixed (SHARED-25037) 

 

7. Running the same job multiple times was sometimes creating inconsistent output. This has 

been fixed (SHARED-25170) 

 

8. PDF and TIFF images in an email body were being converted and attached. This has been 

fixed. (SHARED-26129) 

 

9. When sending Emails records were being skipped when layout errors were encountered. 

This has been fixed (SHARED-27482) 

 

10. When printing via File>Print, the progress bar was only reaching a maximum of 90% when 

printing finished. This has been fixed (SHARED-26638) 

 

11. Split 'At Exactly' was incorrect when set along with Grouping. This has been fixed (SHARED-

26917) 

 

12. When printing via a server from a remote Designer, the output file would remain on the 

server machine. This has been fixed (SHARED-27128) 

 

13. Printing to PCL was sometimes producing a SOFT_MASK_ERROR on images. This has been 

fixed (SHARED-29369) 

 

14. Meta tags were missing in output when “Embed all resources” was set. This has been fixed 

(SHARED-29333) 

 

15. Images using the background image property were not appearing in PDF output. This has 

been fixed (SHARED-27276) 

 

16. Error messages for record based email errors were broken. This has been fixed (SHARED-

27466) 
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17. When using Scalable Vector Graphics (.svg) files as background images, the images would 

not appear in HTML output. This has been fixed (SHARED-28955) 

 

18. The PDF Type was not being remembered in the PDF Options in the Print Wizard. This has 

been fixed (SHARED-28867) 

 

19. Page count\page numbers were incorrect with HCF barcodes. This has been fixed (SHARED-

28787) 

 

20. Bleeds in impositioning has now been fixed (SHARED-28678) 

 
21. External print definitions can also now be used. 

 

22. Hyperlinks were not always working in email output. This has been fixed (SHARED-27966) 

 

23. PDF output did not always contain the full font subset. This occurred when any capitalised 

characters were replaced with symbols and has been fixed (SHARED-27914) 

 

24. When saving a “Job Creation" or "Output Creation" configuration, if the selected name 

contained a full-stop character (.) the correct OL extension would not be appended to the 

name. This has been fixed (SHARED-27923) 

 

25. In jobs with multiple sections that were set to staple at section level, the stapling would not 

occur at the section level but through the entire job. This has been fixed (SHARED-27918) 

 

26. Detail Tables enclosed within <DIV>  elements would not include any extra default rows 

beyond the first row when printed, regardless of how many rows were set. This has been 

fixed (SHARED-27755)  

 
27. Improved speed when loading the Print Wizard and Configuration dialog (SHARED-13731 

and 15264) 

 

28. The From Name and From Email Address values are now stored with the template when 

sending emails (SHARED-24879) 
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1. GoDaddy Certificates 

 
When installing Connect offline, dialogs are available in the setup for installing the GoDaddy 
certificates. Most users will leave the default settings and click “Next”. In some cases however 
this may not work correctly. For this reason users should activate “Place all certificates in the 
following store” and then select the “Trusted Root Certification Authorities” as the target 
certificate store. 
 

2. Server Restart 

 
After installing Connect, a Server restart can sometimes be initiated during the license activation 
which can lock the database and break Connect. In the background it has set a flag in the 
database that cannot be cleared. In order to fix the problem you need to reinstall Connect or 
stop the MySQL table. This issue will be fixed in a later release. 
 

3. Upgrading a Standalone Installation of Designer 

 
If you have installed the Connect Designer version 1.0.0 or 1.0.1 as a standalone, the merge and 
Weaver engines will not start correctly after upgrading to version 1.1.  
 
To fix this problem you need to delete the HSQLDB in the following folder: 
 
C:\Users\{current user}\AppData\Local\Temp\connect.database\ 
 
This database will be reinitialized automatically on the next start-up. The problem will be fixed in 
a later release of Connect. 
 

4. PostScript Print Presets 

 
The print presets for PostScript have been changed in Version 1.1 meaning that some presets 
created in Version 1.0 or 1.0.1 may no longer work. 
 
Any PostScript print preset from Version 1.0 that contains the following will not work in Version 
1.1: *.all[0].* 
 
Any preset containing this code will need to be recreated in Version 1.1. 
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5. Available Printer Models 

 
Note that if you are upgrading from an earlier version of Connect, only one Printer Model will 
appear on the Advanced page of the Print Wizard (Generic PDF by default). From 1.1 onwards 
you need to go to “Window|Preferences|Print|Available Printers” and specify which models you 
wish to be available on the Advanced page of the Print Wizard.  
 
Note that the descriptions of some of the printers have been updated in version 1.1 meaning that 
if you had an earlier version installed, you may find that the same printer appears twice in the list 
with slightly different descriptions.  
 
For example the following default settings are identical: 
 

 Generic PS LEVEL2 (DSC compliant) 

 Generic PS LEVEL2 (DSC) 
 

6. External Resources in Connect 

 
There are certain limitations on how external resources can be used in Connect. For example if 
you want to link a file (e.g., CSS, image, JavaScript etc.) from a location on the network but you 
do not want to have a copy of the file saved with the template you need to do the following: 

 
1. The resource must be located where it can be accessed by all Servers/Slaves run as users. 

Failure to do this will cause the image to appear as a Red X in the output for all documents 
which were merged by engines which could not access the file. The job will terminate 
normally and the error will be logged. 

 
2. The file must be referenced via a UNC path e.g., 

 
file:////w2k8r2envan/z%20images/Picture/Supported/JPG/AB004763.jpg 
 

a. UNC paths are required because the services will be unable to access mapped 
network drives (Windows security feature). 

b. The engine processing the job will look on the local file system for the direct file path 
leading to the “resource not found” issue mentioned above. 
 

Important Note: The Designer itself and Proof Print do not use processes that run as services and 
they may find local files with non-UNC paths which can lead to the false impression that the 
resources are correct. 
 

7. Using Capture After Installing Workflow 8 

After PlanetPress® Workflow 8 has been installed alongside PlanetPress® Workflow 7, Capture 
can no longer be used with Workflow 7. The plugins are now registered uniquely to Workflow 8 
and the messenger for Workflow 7 is taken offline. It is only then possible to use Capture from 
PlanetPress® Workflow 8. 
 

file://w2k8r2envan/z%20images/Picture/Supported/JPG/AB004763.jpg
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8. Capturing Spool Files After Installing Workflow 8 

After PlanetPress® Workflow 8 has been installed alongside PlanetPress® Workflow 7, 
PlanetPress Designer's option to capture spool files from printer queues is no longer functional. 
The solution is to use Workflow 8.x to capture spool files from printer queues. 
 

9. Colour Model in Stylesheets 

In Version 1.1 the colour model of colours defined in a stylesheet can sometimes change after 
editing the stylesheet. This is a known issue and will be addressed in a subsequent release.  
 

10. Business Graphics in Email Output 

Business graphics (pie charts, bar charts etc) are not always appearing in output. This will be fixed 
in a subsequent release. 
 

11. Online Help Links Point to Introductory Page 

Context sensitivity for the online help is disabled in PlanetPress® Connect Version 1.1 meaning 
that all links and F1 calls currently point to the introductory page of the help. Context sensitivity 
will be re-introduced in a subsequent release of PlanetPress® Connect. 
 

12. Legal Notices and Acknowledgements in the Connect About box 

In PlanetPress® Connect Version 1.1, the link to the “Legal Notices and Acknowledgements” in 
the About box currently points to the introductory page of the online help. To read the legal 
notices you must navigate through the online help using either the contents tree or a search. This 
will be addressed in a subsequent release of Connect. 

 

13. Job does not Cancel on Error 

The Designer can sometimes appear to hang when encountering an error. If you then attempt to 
abort the job, the job does not cancel. 
 

14. Black Screen sometimes appearing in the Designer 

The Designer window can sometimes turn black after opening and closing multiple templates. 
This is a known issue and will be addressed in a later release. 
 

15. Registration of PReS Plugin for Watch 

In the current version of PReS (6.3.0) the DLL for the PReS Plugin for Watch has to be installed 
and registered manually. This will be automated with the release of PReS 6.3.1. 
 

16. PDF Output sometimes produces random error 

When running PDF output multiple times, an “Object XX is not defined” error can sometimes 
occur. This problem only occurs on Windows 8.1 and will be fixed in a later release. 
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17. Dragging and Dropping a Step into a Condition 

Dragging and dropping a step into a condition or repeat step can sometimes delete the step. This 
will be addressed in a later release. 
 
 

18. Image Preview in Designer 

If in the Windows Internet settings (Connection Settings -> LAN configuration) a proxy is enabled, 
but "Bypass proxy settings for local addresses" is not checked, the image preview service, 
conversion service and live preview tab in the Designer will not work and exhibit the following 
issues: 

 Images will be shows as 0 size boxes (no red 'X' is displayed) 

 Live preview does not progress, and when re-activated reports "browsers is busy" 

To fix the issue you must check the "Bypass proxy settings for local addresses" option. 
 

19. Encoding 

Issues may sometimes be encountered in menus and templates when running PlanetPress® 
Connect on a non-English operating system. These are due to encoding issues and will be 
addressed in a later release. 
 

20. Templates and Data Mapping Configurations from earlier Betas and Release Candidates 
 

Please note that templates and data mapping configurations created in earlier Betas and Release 
Candidate versions may not open or function correctly in Version 1.1.  

 

21. Merge\Weaver Engines when Printing 
 

The print operation in the Designer will automatically detect whether the Merge\Weaver 
engines are available and display a message for the user to retry or cancel if not. Once the 
Merge\Weaver engine becomes available and the user presses retry the print operation will 
proceed as normal. This message can also occur in the following circumstances: 
 

 If the server is offline and you are not using Proof Print 

 On some occasions before the Print Wizard opens 
 

22. REST Calls for Remote Services 
 

The Server will now accept REST calls for all remote services and will make commands wait 
indefinitely until the required engines become available. The Server will log when it is waiting for 
an engine and when it becomes available. Note that there is no way to cancel any commands 
other than stopping the Server.  
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23. Print Content and Email Content in PlanetPress® Workflow 
 

In PlanetPress® Workflow’s Print Content and Email Content tasks, the option to Update Records 
from Metadata will only work for fields whose data type is set to String in the data model. Fields 
of other types will not be updated in the database and no error will be raised. This will be fixed 
in a later release of PlanetPress® Connect. 
 

24. VIPP Output 
 

Some templates set up with landscape orientation are being produced as portrait in VIPP. It can 
also sometimes be the case that text and images can be slightly displaced. These are known 
issues and will be addressed in a later release of PlanetPress® Connect. 
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25. Print Limitations when the Output Server is located on a different machine 

The following limitation may occur when using the Print options from a Designer located on a 
different machine to the Output Server: 

 The file path for the prompt and directory output modes is evaluated on both the client AND 
server side. When printing to a network share it must be available to BOTH the Designer and 
Server for the job to terminate successfully. 

 The Windows printer must be installed on both the Server and Designer machines. 

 When printing via the Server from a remote Designer, the output file remains on the Server 
machine. 

 
 
 


